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I. Introduction

The FIFRA Work Plan and Report Template is a new format for the FIFRA grantee work plan,
grantee progress reports as well as the year-end evaluation from the EPA regional offices. This
template has not yet been approved under the Paperwork Reduction Act®.

The template includes proposed work activities from the national FY15-17 FIFRA cooperative
agreement guidance, space for proposed and negotiated grantee work activities, space for grantee
progress reports on the negotiated work activities, and space for EPA comments and
recommendations. The template, a result of a collaborative effort involving staff from EPA
regional offices, the Office of Pesticide Programs, the Office of Compliance and several FIFRA
state lead agencies, was created in order to:

1) streamline the cooperative agreement process for grantees and EPA regional offices;

2) promote national consistency in grantee work plans, grantee progress reports and EPA year-
end evaluation reports;

3) more easily allow for the compilation of data, both regionally and nationally; and

4) assist in the design of a new national data system.

While the template is a change in the format of work plans and reports, it does not change the
type of information reported or the processes used by regional offices and grantees in submitting
cooperative agreement applications, negotiating work plan commitments, and reporting on the
progress of those commitments. This template is not intended to change the normal workflow
process between the grantee and the EPA project officer.

With any new tool, there will be a period of learning and adjustment. This instruction manual
focuses solely on explaining how to use the template within the Excel environment. If you are
not familiar with Excel, there are a number of excellent resources available online you can use to
learn the program. Your IT department may have further resources to recommend. Getting to
know Excel will help you in using the template.

! PRA Notice: According to the Paperwork Reduction Act (PRA) (44 USC 3501 et seq.), and the implementing
regulations (5 CFR 1320 et seq.), a Federal agency may not conduct or sponsor, and a person is not required to
respond to, certain collections of information involving identical questions to 10 or more persons unless the agency
has obtained approval from the Office of Management and Budget (OMB). For each such collection activity, the
agency is required to "inform" the respondent that they are not required to respond to the collection of information
unless it displays a valid OMB control number. Failure to display a valid OMB control number permits a
respondent to raise the affirmative legal defense provided by the "public protection” provision in section 3512 of the
PRA (see also 5 CFR 1320.6).

FIFRA Cooperative Agreement reporting is currently approved by OMB under OMB Control No. 2030-0020.
However, the Agency has not yet obtained approval from OMB for this reporting template. Until such approval is
obtained, the reporting template is solely intended to provide respondents with an alternate method of providing
information to the Agency that is already required under the terms of the cooperative agreement. Until OMB
approves the reporting template under the PRA, the PRA’s "public protection” provision will prevent the Agency
from treating the failure to utilize the reporting template as grounds for withholding benefits or imposing penalties.
Instead the agency must permit respondents to prove or satisfy the legal conditions in any other reasonable manner.
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You can refer to this website for help: Microsoft Excel Help and How-to

Another resource is the Help function in Excel. Look for the a icon in the upper right corner
of the screen. You can type questions in the prompt box after clicking on the question mark.

II. Software Needs

The template was designed using Microsoft Office’s Excel 2007, and should run on any newer

version of Excel as well. Functionality of the template might be hampered with Excel versions
older than 2007.

III. Contact Information

If you discover issues or think of better/easier ways that will improve this template, we would
appreciate hearing from you.

For technical questions about Excel, you can call/email either Allen Demorest of EPA
Region 9 (demorest.allen@epa.gov, 415-947-4214) or Jolene Trujillo of OPP
(trugillo.jolene@epa.gov, 703-347-0103).

For policy/process questions that impact more broadly than just a single grantee/project
officer relationship, you can call/email Dea Zimmerman of OPP
(zimmerman.dea@epa.gov, 312-353-6344) or Allen Demorest.

IV. Contents of the Template

The template is comprised of several worksheets, that all appear at the bottom of the screen once
you open the Excel file.

To open a worksheet, you can either click on the name of the worksheet in the Worksheets
section of the Start page,

Worksheets:
Narrative 5700 Main
Budget 57 orker Protection
Work Plan/Report 57mntainer Containment
Outn}wes Performance Measures
Endangered Species

or you can click on the “tab” at the bottom of the template to open a worksheet.

M | Start  Narrative - Budget .~ Work Plan -~ OQutcomes #Ssviiliniriimwrasyiilini A asviiinaes
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To return to the Start worksheet, select the “Back” button at the top of a worksheet or simply
clickon | start .~ from the tabs at the base of the document. If the | Start .~ icon is not visible,
select the ™ icon to page through all the worksheet tabs and then click the | Start . icon.

Worksheets
39 Version 1.0
AN E
H 4 » ¥ | Start ~ Narrative - Budget .~ Work Plan - Outcomes _#sviilihir ~Status— —Prog Area— Sig— ~Act Type— Rec—=rrom || { [ ] Bl |
Ready | 3 [EEEFT e (%)

In order of appearance from left to right, the worksheets contained in the template are:

Start: This is the “cover” page or landing page for the template. This is where the grantee
should begin work by answering the questions numbered 1-8 in the top half of the Start page.
See page 7 for more detailed information.

Narrative: This is the Narrative worksheet where you can add additional narrative descriptions
that don’t fit anywhere else in the template. See page 10 for more detailed information.

Budget: This worksheet is a placeholder for you to either insert your budget sheet into the white
space or embed a separate document into this tab. See page 11 for more detailed information.

Work Plan: This worksheet contains all of the “required” and “pick-list” activities in the
national FY15-17 FIFRA cooperative agreement guidance, contains space for the grantee to
enter in work plan activities and progress reports, and space for EPA to add comments and
recommendations. See page 11 for more detailed information.

Outcomes: This worksheet contains a chart that links program areas, outcomes and the EPA’s
Strategic Plan goals, helping grantees to comply with Grants Policy Issuance 11-03. See page 15
for more detailed information.

Inspection and Enforcement Action/ Projections and Accomplishments Forms
5700 Main: This is the standard 5700-33H form to be filled out by the grantee to project
inspections and samples and report inspection and enforcement accomplishments on a schedule

negotiated with the regional office, annually at a minimum.

5700 WPS: This is the form to report worker protection inspections, samples and enforcement
actions, on a schedule negotiated with the regional office, annually at a minimum.

5700 CC: This is the form to report container/containment inspections, samples and enforcement
actions, on a schedule negotiated with the regional office, annually at a minimum.

ES (Endangered Species Inspections Report): This is the form used to collect information during

use or misuse inspections on whether applicators are following ES Bulletins, on a schedule
negotiated with the regional office, annually at a minimum.
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Perf Meas: This is a placeholder for the enforcement performance measures that are currently
under development, and will be inserted here once finalized.

See pages 15-22 for more detailed information on all the 5700 forms and the ES form.
Standard Reports/My Reports

Reports are an easy way to synthesize information from the work plan worksheet. The template
comes preloaded with some general reports that can be used. However, you can use the pivot
table function in Excel to create a report specific to your needs. You can place your report(s)
under the MY1 tab (stands for My Report 1). See the descriptions of each standard report below.

Status: Activity Status Report. This report lists, by status (partially complete, complete, not
complete or ongoing) the program areas, the work plan activity commitments in the program
areas, the due dates and the activity accomplishments reported by the grantee.

Prog Area: Report by Program Area. This report contains much of the same information as the
Activity Status Report, but sorted by program area rather than status.

Sig: Significant Issues and Innovations Report. This report pulls out all activities that are
flagged as significant or innovative, along with a description of the accomplishment.

Act Type: Activity Type Report. This report, sorted by whether the activity was considered
“required” or a “pick list” activity in the national guidance, will give you a quick view of the
status of those activities.

Rec: EPA Recommendations Report. This report is sorted by program area and will list work
plan accomplishments along with any EPA recommendations, if any.

MY 1: My Report- This is a placeholder for a user created report.

V. General Worksheet Information

A. Protecting Worksheets

Excel has the ability to “protect” a worksheet to prevent users from accidently changing or
deleting important data, formulas, etc. There are six worksheets in the template that are currently
“protected”: Start, Outcomes, 5700 Main, 5700 WPS, 5700 CC and ES. You can enter data into
any of these protected sheets. If you have a need to unprotect a worksheet, go to
Review>(Changes) and select Unprotect Sheet. When done, you may protect the sheet again to
prevent accidental deletion of information. No password is required to protect the sheet, just
select OK. The data entry cells of worksheets remain editable when a sheet is protected.



B. Filters

Filters and drop down options are included to easily sort through the items in that particular
column. For example, at the top of the Work Plan in each of the column headings, you will see a
drop down arrow. Use this to select subsets of information you want to display in that column of
the Work Plan. Make sure to review each arrow as you go through the Work Plan. Don’t forget
to go back and “select all”, otherwise you might think you are missing some of your data!

¢ | | K L

R LYY

J
. eeh . . Activity . e
Activity # 15 - '17 Grant Guidance Activity - Work Plan Activity Description (Outputs) | Due Dgia
v l v v v
I L . . PO . . . s ‘ . 1 , 0

VI. Using the Start Worksheet

The grantee should initially complete work in the Start worksheet.

NOT YET APPROVED UNDER THE PAPERWORK REDUCTION ACT
FIFRA Cooperative Agreement Work Plan and Report

Data entry in white boxes only. Asterik denotes a required field.

Grantee Information: Cooperative Agreement Information: Work Plan/Report Status:
“Name: “Agreement Type: 3) 7

*Grantee: *Number of Years: 4)

Extended to:
*Project Period:

*Work Plan and Report Applies to: | !.

Worksheets: Examples of Standard Reports: My Reports:

Narrative 5700 Main Midyear/End of Year Status Report 1
Budget 5700 Worker Protection Program Area Report
Work Plan/Report 5700 Contalner Containment significant Issue/Innovative Activities
Outcomes Performance Measures Activity Type Report
Endangered Species EPA Recommendations

Reporting Links:
Certification and Training - CPARD References: My References:
Pesticides in Water - POINTS EPA Grant Forms List

Template Instructions/Help

Grant Guidance

K 4 b | Start  Namatve . Budget ~ Work Pen -~ Outcomes dmerdilimir ismr A, vaw, - Stabus~ ~Prog-Area~ ~Sg- ~Act-Typer Reeraciew [0 0 T
Ready | 3 | (8 0 E0j a008,(-) gl
g wr ] W W —




A. Information Required in Top Panel

NOT YET APPROVED UNDER THE PAPERWORK REDUCTION ACT

FIFRA Cooperative Agreement Work Plan and Report 030244

Data entry in white boxes only. Asterik denotes a required field.

Grantee Information: Cooperative Agreement Information: Work Plan/Report Status: Date:
*MName: 1 *Agreement Type: 3] 71 2]
*Grantee: 2] *Mumber of Years: 4]
Start Extended to:
*Project Period: gl

*Work Plan and Report Applies to: I -

The grantee should complete fields 1-8 in the top panel. Some of the responses in these fields
(Grantee and Project Period) autofill other fields within the template (e.g. 5700 forms and
standard reports) and create unique identifiers to aid in data compilation.

Many of the fields have drop down selections that you can choose from. Simply position your
cursor in the white area and click. If there are response choices, a drop down arrow will appear
to the right of the white area. Click on the arrow and the response choices will appear. Select
your response by clicking on it, and it will appear in the white box. To clear contents in a cell,
click in the cell and hit the delete key.

Grantee Information
1) Name: Enter the name of the individual primarily responsible for completing the template.
The name does not have to match the name that appears on the SF-424 form.

2) Grantee: Grantee will select the agency name from the drop down list. Once selected, the
agency name will also appear at the top of the Start worksheet, and on other worksheets. The
EPA regional office associated with the selected agency will also appear below the Grantee
box.

Cooperative Agreement Information
3) Agreement Type: Select from the drop down list the type of Cooperative Agreement
appropriate for your agency: “Consolidated” or “PPG” (Performance Partnership Grant)

4) # Years: Select the number of years (i.e. project period) covered by this cooperative
agreement: 1, 2, 3, or 4 years.

5) Project Period: Select the beginning date of the project period from the drop down list.
Once selected, the end date for the project period along with the supporting budget periods
will autofill on the Start page, and on other forms in the template.



Extended to: This box is only to be filled out if there is a no-cost extension associated
with the cooperative agreement.

6) Work Plan and Report Applies to: Select from the dropdown list the appropriate budget
period to which the work plan applies.

7) Work Plan/Report Status: Select from the drop down list what the current document
represents (i.e. either work plan or report) and its status (choices are: “Work Plan Draft,
Work Plan Final, Work Plan Final Amended, Report Draft, Report Final, Report Final
Amended”). Make sure to save a unique template file for each type and stage of document.

8) Date: Enter the date in mm/dd/yyyy format that corresponds to the type of document in the
Work Plan/Report Status field.

B. Worksheets & Reporting Links

Worksheets:
MNarrative 2700 Main
Budget 5700 Worker Protection
Work Plan/Report 5700 Container Containment
Cutcomes Performance Measures
Endangered Species
Reporting Links:

Certification and Training - CPARD
Pesticides in Water - POINTS

The yellow section in this panel relates mainly to non-inspection related information, while the
blue section relates mainly to inspection related information. Selecting one of the titles takes you
directly to the relevant worksheet.

The links under the pink section in this area link to external databases and are provided here as a

convenience. Click on the link to be taken to the appropriate URL. /! Template users do not
need to report information entered into these databases again in the template.



C. Examples of Standard Reports / My Reports

Examples of Standard Reports: My Reports:
Midyear/End of Year Status Report 1

Program Area Report

Significant Issue/Innovative Activities
Activity Type Report

EPA Recommendations

This panel lists the Standard Reports and My Reports found in the template. Selecting one of the
titles takes you directly to the relevant worksheet.

D. Reference Materials

References: My References:
EPA Grant Forms List

Template Instructions/Help

Grant Guidance

This panel provides access to the various documents that support template users.

References:
EPA Grant Forms List: This link will take you the EPA Grants and Debarment grant forms

page.

Template Instructions/Help: This link takes you to this document if you need to refer to it as
you complete the template.

Grant Guidance: This link takes you to the FY15-17 national FIFRA cooperative agreement
guidance.

My References:

This area provides space for users to add links to any additional reference material the user finds
helpful.

VII. Using the Narrative Worksheet

The Narrative worksheet is where you can add additional narrative descriptions that don’t fit
anywhere else in the template, such as: authority to accept the cooperative agreement, legislative
changes, QAPPs, neutral administrative inspection schemes, case review results, etc.
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You can add narrative either by 1) double clicking on the Word logo, or 2) embedding a
document within the worksheet. Either option allows you to create new material or insert
existing material. To use the second option, go to the menu and click on “Insert”, then click on
“Object”. Here you can choose to create a new file or choose an existing file (Word, PPT, PDF,
JPG, etc.) by selecting “Create from File”, Browse to find your file, and finally choose either
“Link to File” or “Display as Icon”.

VIII. Using the Budget Worksheet

This worksheet 1s a placeholder for you to either enter budget information directly into the white
space or embed a separate document into this tab. To embed a document, go to the menu and
click on “Insert”, then click on “Object”. Here you can choose to create a new file or choose an
existing file (Word, PPT, PDF, etc.) by selecting “Create from File”, Browse to find your file,
and finally choose either “Link to File” or “Display as Icon”.

This budget worksheet is also where you can provide your thoughts on your financial draw down
strategy as described in Grants Policy Issuance 12-06.

IX. Using the Work Plan Worksheet

A. Cell Formatting

Each cell is formatted so that text wraps within each cell, the cell should expand so that all text is
visible, and the text is aligned left and at the top of the cell. However, within the Excel
environment, if you copy and paste text from another source (i.e. another excel file, word
document etc.) the formatting from that source will override these defaults. If you notice that the
format to a particular cell is not following these rules after you’ve added information to a cell,
you can navigate to the “Alignment” section of the Home ribbon in excel and adjust the
formatting of the cell there.

pS. H9-™ Table Tools  Master FIFRA Cooperative Agreement Workplan-Report Template 3-2-14 - Microsoft Bxcel - & x
—7 | Home | Insert Pagelayout  Formulas Data Design @ - ™ x
_J S0 Times ewRom = 114~ [A° x| = 3 FNJee] is , i EJ Zhmwnt o7 @

3 Copy 5 Fi
Faste ¥ Format painter || B2 e blEes B |y A~ = E 8§ Yy v %8s Conae nal »“L cat neert Delete Format et _:\: ;r'\ec:.'
Clipboard i Font = Alignment Number 7 Stytes Celis Editing
K2 - (sl ¥l
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To expand the row height, click on the cell or highlight the row, go to “Cells”, then “Format”,

then select “Autofit Row Height”.

Gp H9- -~ 5 Table Tools  Master FIFRA Cooperative Agreement Workplan-Report Tenlate 3-2-14 - Microsoft Excel - o X
(Ca) -
Home | Insert Page Layout Formulas Data Review  View Developer Design ® - o x
=¥ cut S = e = i} Ceam TR E Autosum - A {
Times NewRom » 14 < |[A° A"| 1= = = | =j* Wrap Text General v g ; ‘@ I, |
Pydes gLy | (G B o3y o= A e i b
Paste ~|fi || S - ~||||= = = | R | Al Merge & Centm - g 3 Conditional Format  Cell Insert Delete [Format ~ sort& Fnd&
- Format Painter (B2 1 [ A E==mel o 8- % o[ A Formatting~ as Table ~ Styles ~ E = - ||| <2 Clear= Filter~ Select~
Clipboard i Font > Alignm ent & Mum ber i Stytes Cells | censize |
K2 - Q ’;'I 3| rowneignt.. ¥
E F G| 1 | K ButoFit Row Helght
9
Activity 1| Column Width. Descri.
Program Area NPM Activity # ‘15 - 17 Grant Guidance Activity Te Work Plan Activity Description (Outputs) Lutofit Column Width y)
1 = = - = E = = - = Default Width... ety =
Basic Pasticide OPP & Comglete administratve/management, fiduciary and Raquired
Program DECA 01.00.01.0 d with this coop [
2 o Hide & Unhide
Basic Pesticide OFPP & Build or maintain siaff and management expertise on Reguired Organize Sheets
Program OECA 01.00.02.0 pesticide program issues and enforcement (e g. attend
7 |training opporiunities through PREP, PIRT, in-semce Bename Sheet
3 training, etcor other appropriate activiti=s) Move or Copy Sheet...
Basic Pesticide OPP & 01.00.03.0 Respond to pesticide inquiries. concems, tips, and Reguired Tab Color »
4 |Program OECA complaints from the public.
Basic Pesticide OPP Provide outreach, communication, and training &s Required Protection
Program propriate as 3 result of new emerging issues, rules, aj Erotect Sheet...
01.01.01.0 gu . and and review & | Lockcen
decisions. pe
5 Format Cells
Basic Pesticide OPP [ﬁewn information on all known or suspected pesticide  |Required I ]
Drnowam 0 04072 0 Lincidanic imnhinn nnl tn (DD fthas kil P

B. Red Triangles in Upper Right Hand Corner of Cells

Instructions within the Work Plan worksheet are indicated by a red triangle in the comer of the
cell. Place your cursor over the triangle for the instructions to appear.

G I /)nj K L
‘ v Y
Activity # '15- "17 Grant Guidance Activity vity Work Plan Activity Description (Outputs) e Date
v i,I l v v l v l v
I . . — P .- - - — - - - . 1 LP— I
Ko v @ Jx |
|4 K | L M N o P
Describe Work Plan Activity Provide concise and descriptive
Work Plan Activity Description (Outputs) | DueDate | Status Accomplishment '“':?’Y'“l t:::.f;e‘:“:nf:ar;“s T
1 [~ [~ v | tinctude any is - | {information and any significant
‘613D12018 ‘ None

C. Column Information and Entering Data

In general, the white areas in the body of any worksheet are meant for data entry.

Program Area (Column E): This listing is taken directly from the national FY'15-17
FIFRA cooperative agreement guidance. Information in this column should not be
changed.
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NPM (Column F): Describes which National Program Manager the grant funding for a
particular work activity comes from: OPP or OECA. Information in this column should
not be changed.

Activity # (Column G): /! This number is unique for each row and matches the activity
number from the national guidance. Do not change the “Activity Number” listed in these
cells. If a row needs to be added, see the instructions below for “adding rows.”

‘15 — 17 Grant Guidance Activity (Column I): /. All of the proposed work activities
listed in column H, FY 15-17 Grant Guidance Activity, are taken directly from the
national cooperative agreement guidance. Do not change anything in this column.

Activity Type (Column J): Describes if the activity is required or pick-list. For all the
pick list activities, the grantee will need to open the drop down list and choose either
“Selected” or “Not Selected” to indicate if the grantee will be doing any work in those
program areas.

If there are supplemental activities or regional specific activities, they are considered
optional until selected or not selected. Those are found at the end of the worksheet.

Work Plan Activity Description (Outputs) (Column K): The grantee will use this cell to
briefly and succinctly describe the Work Plan activity that you will be conducting that
corresponds to the grant guidance activity listed in Column I. Please be as specific as
possible, especially if the activity involves any metrics, locations, etc.

Due Date (Column L): This column auto-fills with the ending date of the budget period
selected from the Start worksheet. If the date is different, the grantee will need to enter
the correct date. Multiple dates may be entered if separated by a comma.

Status (Column M): When reporting results on the activities that you committed to
(according to the schedule you have arranged with your PO), select the current status for
the corresponding activity.

Options in the drop down menu:

- Complete

- Partially complete

- Not started

- Ongoing/ As Needed

Describe Work Plan Activity Accomplishments (Column N): Use this cell to briefly and
succinctly describe the activity accomplishment/status listed in Column K, as well as the
reasons for partially complete/not complete/ongoing/as needed responses in Column M.
Please be as specific as possible, especially if the activity involves any significant
issues or innovations, metrics, locations, etc.

Significant Issues/Innovations (Column O): This column will be used as a means to flag
activities that the grantee feels are either nationally significant issues or activities that




used an innovative approach. There are four options in the drop down menu: “None”
“Innovative,” “Significant Issue,” or “Both”. If anything other than “None” is selected,
please explain the innovation or significant issue, or both, in column N.

EPA Review of Status (Column P): This column is completed by the EPA project
officer/technical contact and indicates the Region’s concurrence or disagreement with the

status reported by the grantee in Columns M and N.

EPA Comment (Column Q): This column 1s completed by the EPA project
officer/technical contact and provides space for any further details the Region wants to
add regarding a particular activity.

EPA Recommendation (Column R): This column is completed by the EPA project
officer/technical contact and provides space for any recommendations the Region wants
to offer.

Additional Columns: Additional columns can be added at the end of the table to add
additional information.

Hidden Columns: These columns are used for creating unique identifiers for the reports
function of the template.

Entity (Column A)

WPStart (Column B)

WPEnd (Column C)

Prog # (Column H): The grant guidance activity number.

. Adding rows

Each guidance activity is initially only given one row in the template, but it is likely that
grantees will have several activities to carry out the guidance and will need additional
TOWS.

To add rows:

Select the row number where you want to add a new row (circled in red), right-click, and
select “Insert.”

Ensure a minimum of one employee obtains and Required
01.02,07.0 [Maintains an EPA inspector's credertial. Conduct FIFRA
TN linspections with EPA credentials, according to EPA

guidances.
Refer all inspections conducted with federal credentials to Required
01.40.08.0 ;
14 the reqion.

The new row will appear with some cells in orange or yellow. The colors are highlighting
that a cell 1s either empty or a duplicate.

Ensure a minimum of one employee obtains and Required

01.02.07.0 imaintains an EPA inspector’'s credential. Conduct FIFRA

inspections with EPA credentials, according to EPA
rocedures and guidances




To complete the data in those two cells, you will select the cell directly above the blank
cell and drag the data down using the small square icon in the bottom right-hand corner

of the cell. )
in:

Er

01.02.07.0|™
N

B

The new row will look like the surrounding cells, however the Activity Code will be
unique.

Ensure a minimum of one employee obtains and Required
01.02.07.0 maintains an EPA inspector's credential. Conduct FIFRA
inspections with EPA credentials, according to EPA
procedures and guidances.

Ensure a minimum of one employee obtains and
maintains an EPA inspector's credential. Conduct FIFRA
inspections with EPA credentials, accarding to EFA
procedures and guidances.

01.02.071

X. Using the Outcomes Worksheet

This chart includes all the program areas listed in the national FY15-17 cooperative agreement
guidance, and links them to the potential outcomes from work done in each program area, and to
the appropriate goal in EPA’s Strategic Plan. The grantee should adjust the outcomes as
necessary to match work contained in the grantee’s Work Plan. This chart, along with the Work
Plan, assists the grantee to comply with Grants Policy Issuance 11-03, which requires all Work
Plans and progress reports to prominently display work commitments, a timeframe to complete
the commitments and a link to EPA’s strategic goal and objective.

XI. Using the 5700 Forms (Projections and Accomplishments)

Guidance for what data to enter into these forms can be found in Appendices 9-11 of the national
FY15-17 FIFRA cooperative agreement guidance. Let’s talk here about how these forms
function in the template.

The template includes three different 5700 forms:

5700 Main: This is the standard 5700-33H form to be filled out by the grantee to project
mspections and samples and report inspection and enforcement accomplishments.

5700 WPS: This is the form to report worker protection inspections, samples and enforcement
actions.

5700 CC: This is the form to report container/containment inspections, samples and enforcement
actions.
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Each of the 5700 forms contains a cell in the upper right hand corner of the form for the grantee
to indicate whether the grantee is reporting “Work Plan Accomplishments” or “Total Program
Accomplishments”. Just click in the cell for the drop down arrow to appear, then click on the
appropriate selection.

iton, DC 20460 Ealb

shment Summary Report

Work Plan Accomplishments

Work Plan Accomplishments

ot Total Program Accomplishments
~ | Imports Exports | Applicator |Use Pesticide
ce
Records Dealers (FTE)

A P A A PN

Each of these three forms has a main summary form and 4 quarterly forms appended below the
summary. All of the quarterly forms for each 5700 area currently “expanded”, leaving them
visible at the bottom of each summary form in sequential order. If you will not use all the
quarters or want to “collapse” them, you will first need to “unprotect” the worksheet. To do this,
go to Review>(Changes) and select Unprotect Sheet. To collapse (or expand) a particular
quarter, click on the minus (or plus) sign to the left of the quarterly forms.

Screen shot of 5700 Main with Q1 visible:
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When done, you may protect the sheet again to prevent accidental deletion of information. No
password is required to protect the sheet, just select OK. The data entry cells of worksheets
remain editable when a sheet is protected.

Any numbers entered in the quarterly report forms will automatically tabulate data in the main
form, regardless of the number of quarterly forms used.

Screen shot of the 5700 Main summary form and Quarter 1:

United States Environmental Protection Agency Washington, DC 20460 Busic
Pesticides Enforcement Cooperative Agreement Projections & Accomplishment Summary Report
StatesTrbe: g Work Plan Accomplishments
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Prysicall 0 0 0 0 l 0 0 [) 0 0 0 0 0
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Screen shot of the 5700 WPS summary form and Quarters 1 and 2:
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United States
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Pesticides Enforcement Cooperative Agreement Accomplishment Report (WPS)
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Enforcement Accomplishments This WPS Tier | WPS Tier Il Fantiies #of
= Claimi iolati i i =
Reporting Year Use For Couse Use For Cause . s Violations During WPS Inspections ,; ., c
Total Inspections Conducted 0 0 0 0 0 0
Physical 0 [ 0 0 0 1 pesticide Safety Training 0
Samples Collected
Documentary 0 0 0 0 0 2 cCentral Posting 0
Civil Complaints Issued 0 0 0 0 0 3 Notice of Application 0
Criminal Actions Referred 0 0 0 )] 0 4 Entry Restrictions 0
Administrative Hearings Conducted 0 Q 0 0 0 5 personal Protactive Equipment [
License/Certificate Suspension 0 0 0 0 0 6 Mix/jLoading, Application Equip & Applications 0
License/Certificate Revocation ] 0 0 0 0 7 Decontamination 0
License/Certificate Conditioning or
Wodification 0 0 0 0 0 8 Emergency Assistance 0
Number of Warnings Issued 0 Q 0 0 0 9 information Exchange Q
Stop-Sale, Seizure, Quarantine or -
Emabargo 0 0 0 0 0 10 Retaliztion 0
Cases Forwarded to EPA for Action 0 0 0 0 0 Total Violations 0
Other Enforcement Actions 0 0 0 0 0
Number of Cases Assessed Fines 0 Q 0 0 0
*This column is a subset of the WPS Tier | and WPS Tier Il Columns combined to collect dat= on inspections conducted at facilities claiming the Immediste Family Exemption
< Summary
te/Tribe: Year: B P emg, #Na Work Plan Accomplishments
nzpactians al
rcement Accomplishments This WPS Tier | WPS Tier Il ﬁ;ig“
ing Y Cleimi #of
eor Use For Cause Use For Cause Total e Violations During WPS Inspections ; _ii:.c
tions Conducted 0
Phvsic
samplos Collo hysical 0 1 Pesticide Safety Training
Documentary| 0 2 Central Posting
Civil Complaints Issué? 3 Notice of Application
Criminal Actions Referre =t try Restrictions
Administrative Hearings Con: . fPersonal Protective Equipment
License/Certificate Suspension E t d t th IMix/Loading, Application Equip & Applications
License/Certificate Revocation (N n er a a ln e pacontamination
License/Certificate Conditioning or fEmergency Assistance
Number of Warnings Issued rt 1 f 1 |information Exchange
Stop-Sae, Setzure, Quarantine or quarterly 1orms only o,
Cases Forwarded to EPA for Action Total Violations 0
Other Enforcement Actions T T T T
Number of Cases Assessed Fif | | | |
R
oo A v Work Plan Accomplishments
hspec
Enforcement Accomplishments This WPS Tier | WPS Tier Il ’FZ,;;’S:"
= . . . . #of
R Year Claiming
eporting Use For Cause Use ForCase | Lo o Violations During WPS Inspections ;...
Total Inspections Conducted
Phys ot =
Samples Collected ysical Pesticide Safety Training
Documentary Central Posting

Civil Complaints Issued

MNotice of Application

Criminal Actions Referred

Entry Restrictions

Administrative Hearings Conducted

License/'Certificate Suspension

Mix/Loading, Application Equip & Applications

License/Cerfificate Revocation

Decontamination

License/Cerfificate Conditioning or

Emergency Assistance

ﬁumber of Warnings Issued

1
2
3
4
5 Personal Protective Equipment
6
7
8
]

Information Exchanze

- IStop.Sale, Seizure, Quarantine or 10 Retsliation
4 <« » »| Start - Narative , Budget . Work Plan -~ Qutcomes , Maas
Reagy | 7
— pr— - L [ W — W

18



Screen shot of the 5700 CC summary form and Quarters 1 and 2:

Bk
United States
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Screen shot of 5700 CC summary form with Q1-4 collapsed:

Back
United States
Environmental Protection Agency
Washington, DC 20460
Pesticides Enforcement Cooperative Agreement Accomplishment Report (Container/Containment)
State/Tribe:  ADEC Year:  FFY17 B lPe: n::g’ 101206 9/3012017 Work Plan Accomplishments
: Enforcement Accomplishments This PEI Non-PEI - . q
e with Container/Containment Violations
Containment | Containment] Total
Total Inepections Conductad 0 0 Refillable Containers
Physical 0 0 1: Deflclerf: Iabelmg ) A
Samples Collected (i.e. clezning and disposal instructions)
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Civil Complaints Issued 0 0 3. Producing establishmeant registration
violations
CrhnallicHaeReicoed 0 0 4. No contract menufacturing agreement,
rasidue removal.instructions, list of acceptable
Administrative Hearings Conducted 0 0 5 DeflflEn‘. management procedures &
operation
License/Certificate Suspension 0 0 6. Record keeping
License/Certificate Revocation 0 0 Containment
Licensc/Certificate Conditioning or 0 0 7. Secondary containment & pads -
Modification capacity/design
Number of Warnings lssued 0 0 8. Secondary contsinment & pads - site
management
Stop-Sale, Scizure, Quarantine or 0 0 9. Secondary containment & pads - record
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Data Entry

Data is only entered in the quarterly forms, and is then automatically summarized in the
main form. Do not use the summary form for data entry. There is one exception. The
grantee will project inspections and samples in the two rows outlined in red in the 5700 Main
form. This is the only data entry that will happen on any 5700 summary form.

Stata/Tribe: ADEC FFY 17 “::3:;‘-’ 1042016 9I30:2047 Work Plan Accomplishments
- - 0f al Certified | Restricted TOTAL
Enforcement Projections & £up PEI M::;# wporis | Exports | Applcator |Use Pestiide
Accomplishments use | Forcause | use |Forcause] Recorés | Dealers
|Projecied: Hrs) 0 0 0 0 0 0 0 0 0 0 0 0
Inspections 0
Samples 0
Accomplished: 0 0 0 0 0 0 0 0 0
= | ~ | a | " s | " ~ I s | L ~ a | n | n
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Example of what a 5700 Main Projections Form might look like as part of the work plan:

United States Environmental Protection Agency Washington, DC 20460 Back

Peslicides Enforcement Cooperative Agreement Projections & Accomplishment Summary Report

State/Tribe: VDACS FFY 16 R;:::Tﬂ 101172015 9130/2016 Work Plan Accomplishments
- ‘ Agricutural Nonagriculiural Certfied | Restrictsd TOTAL
Enforcement Projections & EUP oE| M:I: ':;" mports | Exports | Appiicstor |Uss Pesticids
Accomplishments Use For Cause Usc _ |For Cause Records || Deslers (FTE)
* Projected: {Hrs) 400 400 300 400 500 300 100 200 200 100 100 2600 135
Inspections 20 20 20 20 20 20 20 20 20 20 20 220
Samples 5 5 5 5 5 s 5 5 5 5 5 55
Accomplished: C C 0 0 C C 0 ) i C 0 )
hspectons:  ( 0 0 0 0 0 0 0 0 0 0 4 o
Federal Faciities o o 0 o o o 0 0 o o o 0
Physical 0 0 0 0 0 0 0 0 0 0 0 o
Sampkz =0
Documentary|  © 0 0 0 0 0 0 0 0 0 0 0
- (Accomplished) - (Projected) 400 400 200 400 300 300 00 200 200 00 100 2800
- | hspections @0 @0 (20) 20) 20 @0 (20) 20) @0 @0 (20) (220)
Sampha 5) £) (5) (5) (5) ) (5) (& 5) (5) (5) (55)

« Pesticide Enforcement Actions Taken

Civi Complsints lesued 0 0 0 0 0 0 0 0 0 0 0 0
Ciiminal Aciions Refered o o 0 o o o o 0 o o o 0
- | Administrative Hearngs Conducicd 0 0 0 0 0 0 0 0 0 0 0 0
License/Certificale Suspensior 0 0 0 o o o o 0 o o 0 0
License/Cartficate Revocation 0 0 0 0 0 0 0 0 0 0 [ 0
License/Cartificate Conditicning or Modification 0 [ 0 0 0 o 0 0 0 4 0 0
Number of Warnings Issusd 0 0 0 0 0 0 0 0 0 0 0 0
Stop-Sale, Selzure, Quarnting or Embargo (1] [} 0 ] o (1] 0 0 o o 0 0
Cases Forwarded to EPA for Action 0 ] 0 0 0 0 0 0 0 0 0 0
Other Enforcement Actions 0 0 0 0 0 0 0 0 0 0 0 0
Number of Cases Assessed Fines 0 0 0 0 0 0 0 0 0 0 0 0
otal Number of Actions o [ 0 o o o 0 0 o o 0 0

% of Inspectons Resultng in Actions
M 4> M| Stat  Namative Budget . Work Plan  Outcomes | 5700 Main. - ~Status— ~Prog ~Sig— yp! VYL dll

Ready ] [0 j,a0%

The two rows immediately above the enforcement action rows will tabulate the difference
between projected inspections and samples, and accomplished projection and samples. If the
accomplished number is higher than projected, the difference shows up in black font. If the
accomplished number is lower than projected, the difference shows up in red font. See example
below:

StatefTribe: ~ VDACS FFY 16 n;::g:g 104205 93012016 Work Plan Accomplishments
Enforcement Projections & £up P Mp'-ame:- imporis | Exports Ai:';xg, U::spﬂme TOTAL
Accomplishments Use |ForCause| Use |ForCause] k]| (Bl o (FTE)
* | Projected: (His) 400 400 300 £00 300 300 100 200 200 100 100 2800 135
Inspections 20 20 20 20 20 20 20 20 20 0 20 220
Samples 5 5 5 5 5 5 5 5 5 5 55
Accomplished: 700 500 525 300 200 100 125 0 0 250 175 3475 167
nspections: () 35 25 35 45 10 5 > 0 0 50 35 265
Federal Facilties 0 0 0 0 0 0 0 0 0 0 0 0
Sarmies =45 Fhysical 5 5 5 5 5 S 5 0 0 5 5 45
Y 0 0 0 v 0
mplished) - (Projected) 300 100 225 500 -100 -200 25 -200
< * |nzpections 15 5 15 25 (10) (15) 5 (20)
Samples 0 0 0 0 0 0 0 (5)
I T T T
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Grantees should report inspection and enforcement accomplishment numbers following an
agreed upon schedule between the grantee and the region, but at a minimum, reporting is
required annually.

e Quarterly accomplishments are entered into each of the four quarterly forms appended at
the bottom left of each main page.

e Midyear accomplishments are reported in each of the second quarter (Q2) 5700 forms.

e Annual accomplishments are reported in each of the fourth quarter (Q4) 5700 forms.

XII. Using the Endangered Species Inspections Report

The ES (Endangered Species Inspections Report) tab: This is the form used to collect
information during use or misuse inspections on whether applicators are following ES Bulletins.
This information is required for all grantees whether or not Endangered Species is selected from
the pick-list. For inspections where the applicator is alleged to be in violation of ES labeling
requirements or the Bulletin, please provide the name of the pesticide product involved and the
provision of the ES Bulletin or label violated in the comment field of the form. This information
will help OPP assess the effectiveness of endangered species risk mitigation requirements and
Endangered Species bulletins.

XIII. Using the Template for Multi-Year Agreements

The template functions as a Work Plan and Reports for a one year period. For multi-year
agreements you will need to prepare and save the entire workbook for each fiscal year in the
project period. At the beginning of a multi-year agreement, the grantee may prepare the work
plan for the first year, save that file as a Work Plan by indicating it as a Work Plan in box 7 on
the START page and saving it according to the naming convention below. The grantee can then
use that file as the starting point for preparing the subsequent work plans for the remaining years.
For example, a grantee with a 3 year agreement will submit 3 Work Plans, one for each year of
the agreement, to the regional office.

Once the grantee begins reporting accomplishments on work plan activities for the first year
project period, that file is then saved as a report by indicating it as a report in box 7 on the
START page and saving it according to the naming convention below. Reports are submitted to
the regional office according to an agreed upon schedule between the grantee and the region.
This pattern repeats itself for all years in the project period.

XIV. File Naming Convention

Use of a consistent naming convention will assist with national data compilation. Please follow
the suggested file naming conventions below.
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For Work Plans:

For States

Fiscal year-Two letter state abbreviation-workplan-draft/final-current date
Example: FY13-AL-workplan-draft-020614

For Tribes
Fiscal year-Tribal name abbreviation-workplan-draft/final-current date
Example: FY13-ACIC-workplan-final-030414

For Reports:

For States

Fiscal year-Two letter state abbreviation-report-midyear/yearend-current date
Example: FY13-VT-report-yearend-110514

For Tribes
Fiscal year-Tribal name abbreviation-report-midyear/yearend-current date
Example: FY13-CRST-report-midyear-043014

For Regional Year End Reports:
Fiscal year-Grantee Abbreviation-EPAreport-yearend-current date
Example: FY13-NYSDEC-EPAreport-yearend-021614

XV. Printing

It is strongly encouraged that users print reports rather than worksheets, but should the need arise
to print the individual worksheets follow the instructions below:

-Go to the Office Button

-Select the Print Option and then to go to Print Preview. This view will allow you to see exactly
how the worksheet you have highlighted will print. Scroll through the document and ensure
pages are formatted as desired. The worksheets within the template have been formated to fit on
an 8%" x 11” sheet of paper. On the Work Plan worksheet, columns E through O will print on
one landscape orientated page, with columns P through R on separate pages.

-Then select Page Setup to format the sheet for any specific information you would like to
include for your printing needs (headers, footers, page numbers etc.). The Work Plan worksheet
is formatted so that the column headings will print at the top of each printed page.

-Once you have made any necessary modifications then select Print. Within the print window go

to Print Range>Pages (insert 1 to xx) > OK and the worksheet selected should print clearly with
no extraneous pages.
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For additional printing resources in Excel, look for the d icon in the upper right corner of the
screen. You can type Print in the prompt box after clicking on the question mark and several
informative links will provide detailed printing information.

XVI. Using Standard Reports/My Reports

Helpful Information:

It is recommended that you print a Report (using the pivot table function) with the
information needed. Use one of the reports provided, or one that you’ve created. Then,
from the report, go to View/Workbook Views and select a view to configure your report.
The options that are provided are “page layout” and “page break preview”.

The standard reports will be generated once data is filled into the Work Plan.

To create an individualized report, see: http://office.microsoft.com/en-us/excel-help/create-or-
delete-a-pivottable-or-pivotchart-report-HP010342375.aspx?CTT=5&o0rigin=HP010342752

XVII. Frequently Asked Questions

1) | have discovered an error in or issue with the template. Whom do | contact?

For technical questions about Excel, you can call/email either Allen Demorest of EPA Region 9
(demorest.allen@epa.gov, 415-947-4214) or Jolene Trujillo of OPP (trujillo.jolene@epa.gov,
703-347-0103).

For policy/process questions that impact more broadly than just a single grantee/project officer
relationship, you can call/email Dea Zimmerman of OPP (zimmerman.dea@epa.gov, 312-353-
6344) or Allen Demorest.

2) Something is really missing from this instructions document. Whom do I contact?

See answer to question 2 above.

3) Iam confused by some of the language/abbreviations/acronyms used in the template. Where
can | go for more information?

Check out the Glossary in this document, and if we missed something, let us know so we can add
it.

4) What do | do with the template once it is completed? Is it automatically submitted to EPA?
Who do I submit it to?
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You should follow whatever established cooperative agreement application and reporting
procedures you already have in place. If you are unsure of a process, contact your project
officer/technical contact.

5) How do I submit amendments to my Work Plan? What if my Work Plan changes after it is
approved? Do | make revisions or does the Region?

You should follow whatever established procedures you already have in place for amending your
Work Plan. Discuss the process with your project officer/technical contact. Any amendments to
the grantee’s Work Plan must be made by grantees and then approved by the Region. Make
sure you note any amendments in the Work Plan/ Report Status field (box 7) located on the right
hand side of the top panel on the Start worksheet.

6) Can I attach other documents to the template? How and where do | attach the documents? Is
there a specific format or program attached documents have to be in?

You can paste the content of your narrative document into the “Narrative” worksheet using two
different methods. 1) To cut and paste narrative: Open the Narrative worksheet and double click
on the box labeled “Microsoft Word Document” to open up Word, and then paste the narrative in
that Word document, and close the document when you are done. 2) You can embed a document
into the Narrative worksheet. Go to Insert> Object>. You can create a new document and make
changes there OR you can select an existing file (Word, PPT, PDF, etc.) and embed that into the
Narrative worksheet.

For those forms and documents not included within the template, you should submit them along
with the template following your established procedures.

7) Will I need to submit the template with the other grant forms (SF424, SF 424A,B, SF LLL,
etc.) for a new agreement?

Yes, you will need to submit the template as part of your application package. You should
follow whatever established procedures you already have in place. The template incorporates
your Work Plan and progress reports and does not replace the need for required grant forms.
8) Where do | obtain the 424 and other grant forms?

See the Office of Grants and Debarment website for grant forms:
http://www.epa.qgov/ogd/forms/forms.htm.

9) Do I have to separately send in the 5700 and other reporting forms?

No, all the required 5700 forms are included in the template and do not need to be submitted
separately.

10) Which 5700-33H worksheet should the grantees use to report the mid-year and year-end
numbers?
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Grantees should report mid-year numbers using the Q2 5700 worksheet, and report year-end
numbers using the Q4 5700 worksheet. If a grantee reports inspection and enforcement action
numbers in all four quarters, they will use all four quarterly 5700 worksheets, Q1-Q4.

11) What if I completed additional activities not listed in the template but | want to include them
inmy EOY?

If these additional activities used discretionary funds, they can be included in the
Supplemental/Special Project activity row at the end of the Work Plan worksheet. If these
additional activities fit within one of the program areas, use the “Add a Row” function under the
appropriate program area in the Work Plan worksheet to describe the activity. If the activity fits
neither of these parameters, describe the work in the Narrative worksheet.

12) | cannot get Excel to do what I need it to do. Help?

You can refer to this website for help: Microsoft Excel Help and How-to

Another resource is the Help function in Excel. Look for the {) icon in the upper right corner
of the screen. You can type questions in the prompt box after clicking on the question mark.

13) The template print is too small/large to be useable. How to | make the template larger?
Select the Zoom button in the bottom right of your screen. It should look something like the

following; either click the percentage or use the scrolling bar to enlarge or shrink your screen’s
zoom level.

100% (=) Usaa®)
14) 1 am trying to print my Work Plan as a report. How do I do that?

From the report (either standard or created), go to View/Workbook Views and select a view to
configure your page as you like.

XVIII. Abbreviations and Glossary

CA - Cooperative Agreement

Consolidated — A cooperative agreement having two or more different programs in one
agreement (e.g. enforcement, C&T, program implementation)

CPARD - Certification Plan and Reporting Database

FIFRA - Federal Insecticide Fungicide and Rodenticide Act
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NPM - National Program Manager (EPA term for different offices, such as OPP or
OECA)

OECA - Office of Enforcement and Compliance Assurance
OPP — Office of Pesticide Programs
PPG — Performance Partnership Grant

POINTS - Pesticides of Interest Tracking System
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